
XTimer Q&A      (v1.9 - 1.9.3)

These are about the most common questions sent to me, and the answers 
I typically give:

How do I use XTimer?
Select a rate from the Rate menu.
Push the appropriate buttons on the timer to stop and start it.
Details?    Read the Help.

Where is the online help for XTimer?
Look on the Apple menu after you launch XTimer.    Select, "Help...".    You can
also use command-H to call it up.

Where should I put XTimer?
Read the Help, Section: What Is XTimer?

XTimer's window disappears!
Position XTimer's windows so they are not blocked by the windows of the application in 
front.

Do all the applications that aren't running in front, disappear?    Open your General 
Controls control panel and check the box next to: "Show Desktop When In 
Background."

Is the Auto-Return box checked on the timer?    If XTimer returns to the background 
behind another application's window, try moving XTimer to a different position on your 
desktop, where it is less likely to conflict with other windows.

My online service's rate is changing-- what do I do?
Read the Help - Section:    Setting Charge Rates.

I wish XTimer would launch with the smaller timer window up...
Look at your Preferences.    Tell it to launch minimized.

How do I use that "mini-alias" icon on my desktop?
This is a part of System 7 that many people aren't familiar with.
Here's what to do:

          1.    Make an alias of XTimer.    I usually add the tag "..." onto alias names to let me 
know it's an alias.    Example - "XTimer...".

          2.  Place the alias onto your desktop, in a place that is convenient for you to click 
on when you want to launch XTimer.



         3.    Highlight the alias by clicking on it once (not double-clicking), then Select "Get 
Info" from under the File menu, in the Finder.

          4.    Repeat step 3 by highlighting the mini-icon I included in the XTimer archive you
downloaded, and Selecting "Get Info" for it.

          5.    In the information window that comes up for the mini-icon, click once on the 
icon, then select "Copy" from the Edit menu, or use Command-C.    Close the mini-icon 
information window.

          6.    Click on the icon in the information window that came up for the alias of XTimer
you created.    Now, select "Paste" from the Edit menu, or use Command-V.    This sets 
the mini-icon as a custom icon for the Finder to use with the alias you created.

          7.    Close the information window.    You are done.    You should now have an alias 
with a small icon that takes up less space on your desktop.

How do I use the file, "XT Log Template.FM Pro"?
This is a template you can use to collect XTimer Log data into a FileMaker Pro 
database; if you own and use that program.    It was created by David Wood as an extra 
item to include in the XTimer archive.    If you don't know what FileMaker Pro is or don't 
own it, then you have no need for the template.

How should I set my preferences?
That's up to you.    It all depends on your point of view.    Select the right combination to 
make the program as easy for you to use as possible.    If you'd like an idea of someone 
else's settings to start from, here's how I have mine configured:

Launch Minimized - Check
Reset at Launch - No
Reset after Add/Save - Check
Do Not Verify Resets - Check
Auto-Add Time To Log - Check
Skip Dialog with Notices - Check
Use Cash Register Sound with Notices - Check
Localize Currency Format - Check
Clear Log After Text Saves - No
Always Round Off Seconds - No
Round Before Add/Save - Check
Allow Selection of Multiple Rates When Adding/Saving Time - No
Auto-Tracking Off - No
Prompt To Save Log Before Quitting - No

I can't get XTimer's Log to work.    It logs the current time but won't save previous times.
Use Add Time To... instead of Save Time As...



Better, if you want to add time to the log for the current rate, you can bypass the Add 
dialog and do it quickly by using Ctrl-A.    XTimer can also automatically add the time to 
the log, if you check the preference setting telling it to do that.

I have to pay phone charges as well as online charges, how do I total both?
If they start and stop at the same time, you can create two rates: one for the online fees 
and one for the phone charges.    Check the box in your preferences labeled "Allow 
Selection Of Multiple Rates When Adding/Saving Times.    Then Add/Save times to both 
rates.

If your phone charges and online charges start and stop at different times, this will 
require some ingenuity.    I am in the process of updating XTimer to handle this type of 
problem.    For now, try this work around:    Create a duplicate copy of XTimer and name 
it something clever, like "XTimer 2" (-:      Now, you can launch two copies of XTimer and 
log two times.

NOTE: This can cause problems with XTimer Spy.    You will want to modify the creator 
code of copies of XTimer that you don't use for automatic tracking.    Reason:    XTimer 
Spy looks at the creator code to determine what application to send messages to.    If 
you launch more than one copy of XTimer, it will pick the last one launched to send 
messages to.    Use ResEdit to modify the creator code to '????' on additional copies.    

If you want to take this out further:
With ResEdit, Open the new copy(ies) of XTimer and open up the 'STR#' resource type. 
Select resource ID#4000 and open it.    The first string in the list is the name XTimer 
uses for its preferences file.    Change the name to something different so that your new 
copy of XTimer uses a different prefs file.

Please do not distribute modified copies of XTimer.    Registration allows you to use 
more than 1 copy of XTimer on a single machine, but not to run on more than 1 
machine, unless you register a copy for each machine.

My charges are not figured every minute, they are added at a different interval...
Bummer.    (Ok, I know that's not what you wanted to hear...)    This is a problem to be 
addressed in a version of XTimer I am still working on.

How do I get the general Log's charge totals to show my base monthly service charges?
A few have written asking that the base charges for an account be added to the log total
for rates reflecting FREE hours.    For example, AOL charges $9.95 a month to 
members, which includes 5 hours of time online.    Those hours are termed "Free 
Hours", but in essence they cost $9.95; so some would like the log charge total to show 
that instead of having a zero total.

Here's an idea someone led me to, which may satisfy you until I incorporate something 
like that into the program:    Set your so-called Free rate's charge per hour to the base 
charge divided by the number of hours of Free time included in that amount.    If you 



have a base charge of $9.95 a month divided by 5 hours of time, you could set the 
charge per hour to $1.99.    At the end of 5 hours, your rate's log charge total will say 
$9.95.

XTimer crashes with a Type 1 error-- what do I do?
In the past, this has typically meant that your XTimer Preferences file has become 
corrupted through some kind of disk error.    Trashing the file (located in your 
Preferences folder, in the System folder) resolves that problem.    XTimer now has 
significant changes to verify the preferences file and takes measures to help prevent file
corruption from disk errors and system crashes.    This should help eliminate the 
problem of Type 1 crashes.

Another problem could be that the copy of XTimer you have is somehow corrupted, in 
which case you would need to obtain a new uncorrupted copy to correct the problem.

In rare cases, another program, an extension or control panel, could be conflicting with 
XTimer's operation.    This has occured twice, to my knowledge, with release versions of 
XTimer.    In both instances, the other programs were at fault and needed to be 
corrected.    It is probably not going to be easy to identify the problem, if this should 
occur on your system.    Utilities such a Conflict Catcher can help you determine exactly 
which program conflicts with XTimer, or with a bit of detective work, you can probably 
reach a conclusion as to which it is.    Removing the conflicting program can alleviate the
problem.    Please report this if you think you have found a conflict with another program,
to me, and to the other program's author.    This will help to get things worked out faster 
between the two programs.    (In some cases, though, it is a combination of more than 
two programs that causes the conflict... those are devils to work out!)

How do I get rid of that big ugly shareware screen?
When I receive your registration form and payment, I'll send you a code that will 
customize your copy of XTimer; removing the screen and giving you a new About 
screen with your name on it.

Tips and Suggestions

Tips:
          If you want to keep seperate totals for things like network surcharges, on-line 
connect charges, charges for specific areas of an on-line service, long distance 
charges, etc...    The solution is pretty simple.    In your preferences check the box that 
says, "Allow Selection of Multiple Rates When Adding/Saving".    Then, just set up your 
rates as you like; by choosing "Charge Rates" under the Settings menu; and when you 
Save and Add times, Save and Add to one or more of the rates as needed.    You could 
also set up a category that combines all the charges, so you can see the total it adds up
to.



        You can flip around between the rates while the timer is running, or when it's 
stopped, if you want to peek at the individual totals.    It won't hurt anything.    XTimer is 
tracking the time and calculating the charges based on whatever the current setting of a
rate's charge per hour is (Charges are calculated but never saved to disk...    When you 
Save a time, or Add a time to a rate's total, only the time is saved).    You need only to be
concerned that when you Add to a rate's Log total or Save a time as a rate's Log total, 
that the rate or rates you choose to Add or Save to are the one's you want that time to 
effect.    Note: If the Auto-Add Time feature is checked in your preferences, XTimer will 
add the time on the timer to the logged time for the current rate selected whenever you 
stop the timer.    You don't want to stop the timer in that case, unless the current rate 
selected is the one you want the time added to in the Log.

          Charges = (Rate's Charge Per Hour / 60) x    (#Minutes Logged)

Suggestions
         If you have multiple family members using XTimer, why not keep seperate totals for
each member?

          If your long distance phone bill is eating you alive, take the time to look up how 
much it costs you to call Mom long distance, or whoever you might be calling regularly.   
With XTimer running in front of you, you'll be surprised how much more aware of the 
cost you become.

A Couple of Things to Note

1.    If you like, you can have your own sound played when Notices are sent.    
Just paste one into XTimer with ResEdit.    Make it non-purgeable, with an ID 
of 128. Be sure to use "Get Info" in the Finder, and allocate more RAM to 
XTimer, to accommodate the extra "sound bytes." Give it an extra 15K above
the actual size of the sound for a buffer to prevent memory errors.    

2.    XTimer is designed to liberally surrender CPU time to other applications, 
so it won't slow them down. If XTimer is delayed a second or two from 
updating it's window, don't worry, most likely, it's just letting another 
program have the CPU to do its job.

3.    This is a treat for you people who actually read help documents!    A lot of
author's include "Easter Eggs" in their programs; which are undocumented 
"features" left for hackers and the lucky to find. XTimer has three eggs:

              a.    The first one is caused by holding down a certain combination of 
modifier keys, then selecting "About XTimer" in unregistered versions.

              b.    The second egg is caused by holding down a certain modifier key 
and pressing a certain letter, when a timer window is in front. 



Hmmm... ...what letter would that be?

              c.    The last egg is caused by holding down a certain modifier key 
while clicking the XTimer icon when viewing the log; if you're running XTimer 
on a color monitor. 
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